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Purpose of the Document

The purpose of this document is to explain the QCA4020 which is multi-mode dual band WiFi, Bluetooth
5, and ZigBee (802.15.4). This document contains the features of the QCA4020 and how to configure it.

Document History

Version Author Date Description

A 5G HUB 8.16.2021 Initial Document

QCA4020 miniPCle Copyright © 5GHUB.US



https://5ghub.us/

Table of Contents

PUIPOSE Of ThE DOCUMENT ...ttt e e e e ettt e e e e e e e e e e et breeeeeeaeeeeea e aansbssaaeaaeaaaaeeeeeaaansssrsanees 2
(B ToTol0 10 o¥=T o} dl o 1) o] Y T PP TPPPPPPPPN 2
1 INEFOAUCTION L.ttt sa et e st e st esnbe e e smbee e saneeesanee 4
2 QCA4020 MINIPCIE LAYOUL....eiiiiiiiiiiiiiieetr et e e e e e e reeeee s 5
3 QCAZA020 MINIPCIE PiN OUL.cieiieiiitieeitee ettt ettt e sttt e et e e st e e sabeee sttt e sabeeeesaneeesareeenas 6
4 How to flash Image to QCA4020 MINIPCIE........uuiiiiiiiiiiee et e e e s 9
4.1 Method 1: Through Emergency Download Mode (EDL) ......cccveveeeiiiiieeeeciiiieeeeeceeeee e 9
4.2 Method 2: TRFOUZN JTAG ..cooeiiieeee et e e e e e e e st e e e e e e e e e s s sastabaraeeeeaaaaeeas 9
5 QUCAZD20 PN OUL oottt e s e s e e e e e e e e e e e e ettt e e e e e e e e e bbababbs s ssasesseeeaaaaaaanaaanans 10
6 Software Tools t0 be INStalled .........eeiiiiiiee e e e 12
7 Setting Up the Software Development ENVironmMent.........ccccvvveeeeeeieii e 12
2% R 2 o Vo T UUPRPUN 12
2 - |- T OO 12
7.3 OPENOCD ...ttt ettt e e ettt e e e et et e e e e e ae bt e e e e et bt e e eetebh e e eeterra e eaarans 12
7.4 GNU ARM TOOICN@IN «.eeiiiiiiiieiiee ettt st et e s bt e s e e s areeesaneee 13
7.5  Setup OpenOCD Plugin Usage With EClipSe.........coiiiiiiiiiiiiiiiiie e 13
8 Importing “Hello World” APPlCation .........ceeeiii i i e 15
9 Building “Hello World” APPlICatioNn .......ueeeeiiiiii ettt e e e e e e e re e e e e e e 18
10 Flash the Application to the QCA4020 miniPCle using USB .........ccooiiriiriiriericerce e 21
11 Flash the Application to the QCA4020 miniPCle USING JTAG ....coovvveciiiiiiiiieeiee e 23
12 Connecting QCA4020 to Serial Terminal Through UART .....ccoiiiiiiiiiiiiiiieeeeece e 26
13 U Y= YT = N =T o o1 = | 27
14 QCLI DEMO APPIICALION L.ttt e e e e e et e e e e e e e e e e e s ararbaraaeeaaeas 30

QCA4020 miniPCle Copyright © 5GHUB.US



https://5ghub.us/

1 Introduction

This is a miniPCle card that supports multi-mode intelligent connectivity. It supports dual-band WiFi,
Bluetooth 5, and ZigBee. It is based on Qualcomm QCA4020 System-On-Chip (SoC). It has low power SoC
that integrates a Cortex M4F for application processing, Cortex MO for network stack processing,
and a separate processor for Wi-Fi stack designed to enable a highly concurrent multiple radio
solution.

The QCA4020 SDK pre-integrates support for advanced security features and multiple software
and cloud ecosystems.

Designed to address loT fragmentation and support for interoperability, this solution is ideal for
multiple 1oT industries from home control and automation, networking, home entertainment and
smart cities.

Feature Highlights

e  Multi-mode SoC supporting dual band Wi-Fi, Bluetooth 5, and IEEE 802.15.4 concurrently

e Dedicated processor for Bluetooth LE LC and 15.4 MAC

e Dedicated processor for 802.11 a/b/g/n

e Zigbee 3.0 and OpenThread support

e Isolated power islands for low power operation

e Advanced hardware-based security featuring secure boot, trusted execution environment,
encrypted storage, key provisioning and application-level security

e Comprehensive set of peripherals and interfaces: SPI, 12C, UART, HS-UART, ADC and GPIOs

e 300+KB RAM reserved for applications

e Bluetooth radio details: v5.0 with PA =+4dBm/+10dBm (for Long Range)

e 802.15.4 radio details: 2006 compliant, 15.4e, 2.4GHz DSSS +4dBm/+21dBm (for Long Range)

Specifications

Wi-Fi

Standards: 802.11a/b/g, 802.11n
Wi-Fi Spectral Bands: 2.4 GHz, 5 GHz
Peak Speed: 150 Mbps

MIMO Configuration: 1x1 (1-stream)

Bluetooth
Bluetooth Specification Version: Bluetooth 5.0
Bluetooth Technology: Qualcomm Bluetooth mesh, Bluetooth Low Energy

802.15.4
LR-WPAN Protocol: Thread, Zigbee

uSB
USB Version: USB 2.0
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CPU
CPU Clock Speed: Up to 128 MHz
CPU Cores: Arm Cortex-M4F CPU, Arm Cortex-MO CPU, Tensilica Xtensa

Security Support

Security Features: Application-level Security, Hardware-based Crypto Engine, Key Provisioning
Security, Qualcomm® Trusted Execution Environment (TEE), Secure Boot, Secure Storage, Software
Image Encryption, True Random Number Generator

Wi-Fi Security: WPS Interface

2 QCA4020 miniPCle Layout

The following figure explains the QCA4020 miniPCle. It has two headers P1 and P2 which exposes many
of the GPIOs and interface of the QCA4020. In addition, it has a JTAG interface for debugging and flashing
image. In addition, it has Emergency Download Mode (EDL) jumper header.

1°CA 105 W

! 1 IC 1D: 26025-WL501
MAC:

1- QCA402 M20 module

2- miniPCle Interface

3- J3 (EDL)

4- J2 (configure JTAG interface)
5- J1 (Force JTAG)

6- P2 Header

7- P1 Header

8- JTAG Interface

Figure 1: QCA4020 miniPCle Layout.
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The following figure shows the size and dimension of the QCA4020 miniPCle.
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Figure 2: QCA4020 miniPCle Physical Dimension.

3 QCA4020 miniPCle Pin Out

The QCA4020 is miniPCle card and interface. The following figure shows the pin out of the miniPCle:

Copyright © 5GHUB.US
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VCC_3V3  WAKE#
e
S UARTO_RX
R
] CHIP_PWD_L BE
D B 1oC MASTER SCL

DTR 12C_MASTER_SDA
UsB20_DM_BE ]
]
SPI_SLAVE_CLK
: SPI_SLAVE_MOSI
L B 5Pl SLAVE MISO

Pin 52 [N SPI_SLAVE_CS_N

Figure 3: QCA4020 miniPCle Pin out.

Bottom

To use the miniPCle module, you can use USB adaptor (also know as Raspberry PI HAT). The miniPCle pin
mapping as in the table below. If the miniPCle is used with he Raspberry Pl HAT, miniPCle pins are mapped
to Raspberry Pl for additional functionality and interface to Raspberry PI.

Table 1: QCA4020 miniPCle Interface.

PIN # QCA4020 QCA4020 GPIO | Raspberry Pl PIN#
PIN#
1 WAKE-UP GPI1029_BE
2 VCC_3V3
3
4
5
6
7
8
9
10
11 MO&M4_UARTO_RX GPIO8_BE GPIO 14 (8)
12
13 MO&M4_UARTO_TX GPIO9_BE GPIO 15 (10)
14
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15

16

17

18

19

20

21

22

CHIP_PWD_L_BE

T4

23

24

25

26

27

28

29

30

12C0_MASTER_SCL

GPIO10_BE

GPIO 19 (35)

31

DTR

33

32

12CO_MASTER_SDA

GPIO11_BE

GPIO 18 (12)

33

34

35

36

USB20_DM_BE

USB20_DM_BE

37

38

USB20_DP_BE

USB20_DP_BE

39

40

41

42

LED_ZIGBEE

GPIO13_BE

43

44

45

SPI_SLAVE_CLK

GPIO18_BE

GPIO 11 (23)

46

LED_BLE

GPIO60_BE

47

SPI_SLAVE_MOSI

GPI023_BE

GPIO 9 (21)

48

LED_WLAN

GPIO12_BE

49

SPI_SLAVE_MISO

GPI020_BE

GPIO 10 (19)

50

51

SPI_SLAVE_CS_N

GPIO19_BE

GPIO 8 (24)

52

QCA4020 miniPCle
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4 How to flash Image to QCA4020 miniPCle

Flashing the image o the QCA4020 miniPCle can be done using either of the following two methods:

4.1 Method 1: Through Emergency Download Mode (EDL)

In this step up, user can do the following:

1- ConnectJ3 (PIN 1 and PIN 2). This is the GPIO22_BE used for EDL.
2- Connect the USB cable between the PC and the USB port of M20.

4.2 Method 2: Through JTAG

In this step up, user can do the following:

1- ConnectJ1 (PIN 1 and PIN 2). This is the GPI020_BE which used to force JTAG mode
2- Connect JTAG cable to the JTAG 10-PIN header which includes the signals TCK, TDI, TDO, TMS

Follow normal procedure to flash the *.elf file over the JTAG interface.

QCA4020 JTAG pins used as in the following Table:

Table 2: JTAG Interface.

QCA4020 PIN# JTAG Signal
GPIO_50 JTAG3_BE_TCK
GPIO_51 JTAG3_BE_TDO
GPIO_52 JTAG3_BE_TMS
GPIO_53 JTAG3_BE_TDI

J2 on the QCA4020 is used to configure JTAG. Connecting J2 (PIN 1 and PIN2), force the following JTAG
configuration:

Table 3: J2 Setting for JTAG Interface.

Boot_Configure_B | Boot_Configure_B | Boot_Configure_BE | JTAG Interface
E_OGPIO_9_BE E_1GPIO_25_BE _2GPIO_18_BE for M4
0 0 1 JTAG in
GPIO[53:50]
QCA4020 miniPCle Copyright © 5GHUB.US
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5 QCA4020 Pin Out

The QCA4020 has abundant number of pins and GPIOs and functionalities which are exposed through P1 and P2 jumper headers. The following
table summarizes all pins exposed through P1 and P2 jumper headers and their hardware functionalities.

Table 4: P1 and P2 PIN Mapping.

Header and PIN GPIO # SP1/12C/QSPI UART AT PTA
SenseADC

P2-PIN1 3.3V
P2-PIN 2 GPIO4_BE
P2-PIN3 GPIO5_BE BT_ACTIVE
P2-PIN 4 GPIO6_BE WLAN_ACTIVE
P2-PINS5 GPIO7_BE BT_ PRIORITY
P2-PIN6 GPI014_BE HS_UARTO_DM_CTS
P2-PIN7 GPI015_BE HS_UARTO_DM_TXD
P2-PINS GPI016_BE 12C1_Master_SCL HS_UARTO_DM_RFR BT_ ACTIVE
P2-PIN9 GPIO17_BE I2C1_Master_SDA | HS_UARTO_DM_RXD WLAN_ACTIVE

P2 - PIN 10 GPI024_BE

P2-PIN 11 GPl026_BE

P2 - PIN 12 GPI027_BE

QCA4020 miniPCle Copyright © 5GHUB.US
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P2 - PIN 13 GPIO28_BE
P2 - PIN 14 GPIO30_BE
P2 - PIN 15 GPIO31_BE
P2 - PIN 16 GPIO32_BE
P2 - PIN 17 GPIO33_BE
P2 - PIN 18 GND
AO
P1-PIN10 (SENSEADC_1_BE)
Al
P1-PINO (SENSEADC_O_BE)
P1-PINS8 GPIO_41_BE
PL—PIN7 GPIO48_BE
P1-PING GPI049_BE
P1-PINS GPIO54_BE SENSEADC2
P1-PIN4 GPIO55_BE SENSEADC3
P1-PIN3 GPI056_BE SENSEADC4
P1-PIN2 GPIO57_BE SENSEADCS
P1-PIN1 GPIO58_BE SENSEADC6

QCA4020 miniPCle
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6 Software Tools to be Installed

Please install the following tools

Python 2.7.X (Download Python | Python.org)

Eclipse IDE for C/C++ (Eclipse IDE for C/C++ Developers | Eclipse Packages)
This is a GUI-based integrated development environment

Supported Version: Oxygen version - Release 4.7.2

Java:

Eclipse IDE has dependency on Java, JDK 8 or higher

OpenOCD (Download OpenOCD for Windows (gnutoolchains.com))
version 0.10.0 [2017-06-09]

GNU Arm Embedded Toolchain (GNU ARM Toolchain)

version 6.x

Qualcomm SDK for QCA4020: The SDK contains sample demo applications with source code to
demonstrate different features and technologies that QCA4020 supports.

7 Setting Up the Software Development Environment

7.1 Python
After installing Python, add the path to python.

Example:
If python.exe is in the folder

’ C:\CRMApps\Apps\Python276-64

set path as follows:

’ %PATH%=%PATH%:C:\CRMApps\Apps\Python276-64

7.2 Java
After installing Java, add path to Java.

Example:
If Java.exe is in the folder

‘ C:\ProgramData\Oracle\Java\javapath

set path as follows:

‘ %PATH%=%PATH%: C:\Program Files\Java\jdk1.8.0_161\bin

7.3 OpenOCD

OpenOCD plugin is required to establish the connection between Eclipse IDE and onboard FTDI JTAG

debugger. After installation, add the path to OpenOCD.

Example:
If openocd.exe is in the folder

QCA4020 miniPCle Copyright © 5GHUB.US
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https://www.python.org/downloads/
https://www.eclipse.org/downloads/packages/release/oxygen/3a/eclipse-ide-cc-developers
https://gnutoolchains.com/arm-eabi/openocd/
https://developer.arm.com/-/media/Files/downloads/gnu-rm/6-2017q2/gcc-arm-none-eabi-6-2017-q2-update-win32-sha2.exe?revision=419232c3-aefe-4049-a88a-7b4ea055ebc7?product=GNU%20Arm%20Embedded%20Toolchain,32-bit,,Windows,6-2017-q2-update

‘ C:\Program Files\OpenOCD-20170609\bin ‘
set path as follows:

| set %PATH%=%PATH%:C:\Program Files\OpenOCD-20170609\bin |

7.4 GNU ARM Toolchain
Install the ARM toolchain by running the “.exe” file and make sure you select the option to “Add path to
environment variables” during the final step.

7.5 Setup OpenOCD Plugin Usage with Eclipse

Do the following steps:

1- Go to Help > Install new software in Eclipse IDE and make sure the following plugin are installed and
enabled by default.

= eclipse-workspace - Eclipse IDE - m} X
File Edit Source Refacter Mavigate Search Project Run  Window Help
(il [ ®~K|-E D%ie|Lig- 6~ [ @ Welome
Ao oo id @ Help Contents Q |
[y Project Explorer 4 Search BESY § == .E
& Helloworld_demo Show Contextual Help =
Show Active Keybindings... Ctrl+Shift+L e
£ Tips and Tricks... 2
Cheat Sheets... i
@ Eclipse User Storage » 5‘
":3 Perform Setup Tasks... O
s Check for Updates
@ Install New Software... 5
o-
@ Eclipse Marketplace... o=
= About Eclipse IDE @
¥ Donate
Contribute
b§ Helloworld_demo
QCA4020 miniPCle Copyright © 5GHUB.US
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S Preferences O %4
type filter text | Softy Sites - ~ 8
General
C/Css ‘typeﬁlter text x‘
Changelog
Docker Name Location Add...
Help ¥l 2021-03 http://download.eclipse.org/releases/2021-03 a0
h In;tAaII.fUpdateU " O «cor http://download.eclipse.org/tools/cdt/releases/10.2 !
Aut.o‘n:t\; ftwatesSt vﬂCD‘T https://download.eclipse.org/tools/cdt/releases/10.2 Mo
L S RESes #fl Embedded C/C++ vbx Updates  hitpsi//download.eclipse.org/embed-cdt/updates/vé/
ibrary Hover
Mcury ] Latest Eclipse IDE Packages Release  https://download.eclipse.org/technology/epp/packages/latest/ Reload
Mylyn vﬂ Latest Eclipse Simultaneous Release  https://download.eclipse.org/releases/latest
Oomph O 4l Linwx Tools hitp://download.eclipse.org/linuxtools/update il
Remote Development ¥ The Eclipse Project Updates http://download.eclipse.org/eclipse/updates/4.19 et
RPM O vﬂTrace Compass http://download.eclipse.org/tracecompass/master/repository
Run/Debug [ 4l Trace Compass Incubator http://download.eclipse.arg/tracecompass.incubatar/stable-6.3... B
SWTChart Extensions
Terminal
TextMate
Tracing
Validation
Version Contral (Tearn) < >
XML
@ IQ Ié; Apply and Close Cancel

2- Set path to openOCD. Restart the Eclipse IDE and under Window -> preferences. Set path to openOCD

as seen below:

-
& Preferences

type filter text

C/C++

Changelog

Docker

Help

Install/Update

Library Howver

v MCU

Global Arm Toelchains Paths
Global Build Tools Path
Global OpenOCD Path
Global pyOCD Path
Global QEMU Path
Global RISC-V Toolchains Paths
Global SEGGER J-Link Path
Workspace Arm Toolchains Paths
Workspace Build Tools Path
Workspace OpenOCD Path
Workspace pyOCD Path
Workspace QEMU Path
Workspace RISC-V Toolchains Paths
Workspace SEGGER J-Link Path

Mylyn

Oomph

Remote Development

[m] x

Global OpenOCD Path = v 8

Configure the location where xPack OpenOCD is installed. The values are stored within Eclipse. Unless redefined more
specifically, they are used for all projects in all workspaces.

After installing OpenOCD updates, restart Eclipse for the defaults to be re-evaluated and use the Restore Defaults button to
configure the new location.

Executable: | openocd.exe

Folder: | CANB_loT_Projects\PCBandGitHub\Tools\OpenOCD-20170609-0.10.00bin Browse... xPack...

Restore Defaults Apply

@Meh®

Apply and Close Cancel

3- After installing the Qualcomm SDK, QCA4020 OEM SDK+CDB, Demos samples are in the following

folder:

‘ target\quart\demo\

QCA4020 miniPCle
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4- Install the QCA plugin jar file available at

<SDK_source>/target/quartz/demo/EclipseSupportFiles

- Copy the jar file (QCA402x_plugin.jar) to the “dropin” folder under the Eclipse IDE installed folder.

- Restart the Eclipse IDE if running. To restart Eclipse, click on the File->Restart after the plug-in is

installed.

5- Make sure all environment variables are set up correctly

Edit environment variable

ChUsers\hossatAppDatatLocal\Programs'\Python\Python27

C:\Program Files (x86)\GNU Arm Embedded Toolchain’ 10 2020-g4-major'bin
CANB_loT_Projects\PCBand GitHub'\ Tools\ 0 penQCD-20170609-0.10.00bin
C:\Program Files\Java'jdk1.8.0_291\bin

%USERPROFILE\AppDatat Local\Microsoft\WindowsApps
ChlUsershhossatAppDatat Local\GitHubDesktopibin

CAMinGWhbin

Chlsers\hossat\AppDatatLocal\Programs\Microsoft Vs Codelbin
Ch\Users\hossalAppData\Roaminginpm

Move Up

Move Down

Edit text...

Cancel

8 Importing “Hello World” Application

1- Install Eclipse project files for sample demo applications. To install there is eclipseSupport.bat for

Windows and eclipseSupport.sh for Linux in the following folder:

‘ <SDK_source>/target

2- Open a terminal window and navigate to

‘ <SDK_source>/target

3- Run the following command

‘ sh eclipseSupport.sh

Or

QCA4020 miniPCle Copyright © 5GHUB.US
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eclipseSupport.bat

After executing the script, the Eclipse project files .cproject, .project and .settings folder are updated
in the respective folders of the demo application.

4- Open Eclipse application and Go to File->Open Project and choose the folder of the “Hello World”
application and check the box beside the application. Click Finish

S Import Projects from File System or Archive ]

Import Projects from File System or Archive

X
—
€ Invalid directory or archive file / 7

[ g N eaot I\ OCA4020\SDK\ qca4020-or-3-4_gca_oem_sdk-cdb-master-2e23b7b0933311233d c090ed0f647de9b31d7954\target\quartz\demo\Helloworld_dem: ]| Directory... Archive...
type filter text \ Select All
Folder Import as Deselect All

0 of 1 selected

[ Hide already open projects

[ Close newly imported projects upon completien
Use installed project configurators to:

Search for nested projects

Detect and configure project natures

Working sets
[1Add project to working sets New...
Select...
Show other specialized import wizards
;?'\
@ <Back Next > Finish Cancel

5- To debug the project, set the Debug Config. Go to Run->Debug Configuration->GDB OpenOCD. Set the
Application and OpenOCD options as show in the images below. Select Quartz.elf as the C/C++ application.
If you have already built the image, select Disable auto build. If image is not built, select Use workspace
settings.

QCA4020 miniPCle Copyright © 5GHUB.US
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= Debug Configurations m}
Create, manage, and run configurations
CE®BEX DT~ Name: | Helloworld_demo
[ype filter text ] Main| %5 Debugger| b Startup| & Source| [T] Common| 2, SVD Path
[E] C/C++ Application Project:
[€] C/C++ Attach to Application
[E] C/C++ Container Launcher [ Hetlo worla Browse...
[£] C/C++ Postmortem Debugger C/C++ Application:
CEI; E”: E:: E::"te Application [kenacaaoac sk qead020-or-3-4_gea_oem _sclk-cdb-master-223b7b0933311233dc090ed0f647de9b 317954 targ et\ quartz\demo\ Helloworld_demo\build\gecioutput\ Quartz.eff
[£] GDE Hardware Debugging Variables.. | Search Project...| | Browse..
v [£] DB OpenOCD Debugging e s e
[£] Helloworld_demo
[£] GDE PyOCD Debugging Build Configuratien: | Use Active ~
GDB QEMU Debuggin
%GDB SEGGERJ_LIEED:MQWQ O Enable aute build O Disable auto build
# Launch Group ® Use workspace settings Configure Workspace Settings...
Revert Appl
Filter matched 13 of 13 ftems e i
@
6- In the Debugger window, provide the openocd executable path with config option
-f ${project_loc}\build\gcc\qcad02x_openocd.cfg
7- Provide the arm-none-eabi-dgb executable path for the GDB client as seen below.
= Debug Configurations m}
Create, manage, and run configurations
CEeEX BT~ Name: | Hellowsrld_deme
[type filter text | Main | %5 Debugger | = Startup| & Source| [T Common| 2., SVD Path
C/C++ Application Open0CD Setup ~
[E] C/C++ Attach to Application Start Open0CD locally
[E] C/C++ Container Launcher - -
C/Ce+ Postmortem Debugger Exccutable path: | CfTools\ OpenOCD-20170603-0.10.0\bin'openocd.exe Browse...  Variables...
[E] C/C++ Remote Application Actual executable: | C:\Tools\OpenOCD-20170609-0.10.0\bin\openocd.exe
Cif C/Cx+ Unit {to change it use the global or workspace preferences pages or the project properties page)
[] GDB Hardware Debugging
+ [T] GDE Open0CD Debugging GDB port:
[c] Helloworld_demo Telnet port:
[] GDB PyOCD Debugging
[£] GDB QEMU Debugging Tel port:
[E] GDB SEGGER J-Link Debugging Config options: [ _f C:5\QCA4020\5DK\qca4020-0r-3-4_gea_oem_sdk-cdb-master-2e236700933311233dc090ed0f647de0b31 47954\ target\ quartzideme
i Launch Group \Hellewerld_demch\build\gcc\qead02x_openocd.cfy
Allacate console for OpenOCD Allocate cansole for the telnet connection
GDB Client Setup
[] Start GDB session
Exccutable neme: | C\Program Files (x86]\GNU Tools ARM Embedded\6 2017-g2-update\bin\arm-none-cabi-gdb.cxe Browse...  Variables...
Actual executable: | C\Program Files (x86)\GNU Tools ARM Embedded\6 2017-q2-update\bi m-n bi-gdb.exe |
Other options: | [l
Revert Appl
Filter matched 13 of 13 items e ik
@

QCA4020 miniPCle

Copyright © 5GHUB.US



https://5ghub.us/

9 Building “Hello World” Application

To build the application, do the following:

1. Go to Project properties->Configure build. Right-click on the project name in project explorer and

go to Properties

2. Verify the build command and the build directory in the Builder settings tab.
3. Go to C/C++ build and set the build command to “build.bat”, and the build directory to “path to

source” as in the following screenshots.
4. Click Apply and Close

S Properties for Helloworld_demo

m} et

Grh v §

type filter text | | c/€e+ Build
Resource
Builders
CfC++ Build Configuration: |Default [ Active ]

C/C++ General
Linux Tools Path

~ | | Manage Configurations...

C/C++ General
Linux Tools Path
Project Matures
Project References
Run/Debug Settings
Task Repository
Task Tags

Validation

WikiText

[El Builder Settings @ Behavior & Refresh Policy

Build settings
Stop on first build error

Workbench Build Behavior

Workbench build type: Make build target:

[“1Enable parallel build

Use optimal jobs (12]

Use parallel jobs:

Use unlimited jobs

Project Matures = Builder Settings (@) Behavior < Refresh Policy
Project References .
Run/Debug Settings Builder
Task Repository Builder type: External builder
Task Tags [ Use default build command
Validation
WikiText Build command: | build bat Variables...
Makefile generation
[] Generate Makefiles automatically Expand Env. Variable Refs in Makefiles
Build location
Build directory: | ${workspace_loc:/Helloworld_demo/build/gecc}
Workspace... | File system... | Variables...
Restore Defaults Apply
® Apply and Close Cancel
-
‘S Properties for Hellowarld_demo m} bl
type filter text || escs+ Build Gror
Resource
Builders
C/C++ Build Configuration: |Default [ Active ] ~ | | Manage Configurations...

[1Build on resource save (Auto build) | all Variables...
Note: See Workbench automatic build preference
[ Build (Incremental build) [ 4020 cdlb 2p0 | | Variables...
& Clean [ clobber | | variables...
Restare Defaults Apply
® Apply and Close Cancel

QCA4020 miniPCle Copyright © 5GHUB.US
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5. Build the application and you will see the following message in the Console Window

‘= eclipse-workspace - Eclipse IDE — | X

File Edit Source Refactor Mavigate Search Project Run  Window Help

i] = |[®@-8-BB% e[S -&-F-G-%-0-0-Q%-®p ¥-F[E
I - = o v v| # Q @\ )
[ Project Explorer Iu‘_ Problems J| Tasks (& Console [T] Properties b 4 | &€ 4 <‘q_>| BB REI=|B E| B 5‘
{3§ Helloworld_demo CDT Build Console [Helloworld_demao] =
18:51:55 **** Incremental Build of configuration Default for project Helloworld demo **** B
build.bat t 4820 cdb 2pe &
Python version:Python 3.9.5 =]
Building Quartz Helloworld Demo for w2 Chipset S|
RTOS threadx —
CHIPSET VARIANT qcad482e a
Exporting Device config files.... im}
GENERATING DEVCFG. ... o
Building hello world.c =
Building palipal.c o
Building exporti\platform_cem.c o=
Building exportiplatform_cem_som.c []

Building exportiplatform_cem_mom.c
Building export\DALConfig_devcfg.c
Building export\DALConfig_fom.c
Building exportidevcfg_devcfg_data.c
Building exportidevcfg_fom_data.c
Building export\UsrEDL.c

Building export\flash_init_config.c
Attempting to convert windows paths: output\LinkerLibs.txt
Generating Linker Scripts...
Linking...

Hashing...

18:53:16 Build Finished. @ errors, @ warnings. (tock 1lm:21s.44ms)

[

The output and *.elf files are generated and available under the output folder:
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— O >
¢ Open ~ Select all
Edit Select none
History i~ Invert selection
Select
2 Search output

Type Size

File folder

Text Document 4

ELF File 15,428

LD File 472

Linker Address Map 9811

ELF File 430

HASH File 1

MEM File 1

HD File 1

ELF File 436

ELF File 436

PBM File 430

ELF File 19,428
>

[ + | output
Home Share View
* o Cut I T \/‘I
u w-| Copy path “‘:I x ﬂ = .
Pinto Quick Copy Paste _ Move Copy Delete Rename Mew Properties
access [7] Pasteshartcut g to - folder - &
Clipboard Organize Mew Open
« A <« quartz » demo » Helloworld_demo » build » gcc » output v | D
) MName Date modified
o Quick access
ohjs /18/2021 714 PM
I Desktop b 4 ) )
| LinkerLibs.txt 8/18/2021 714 PM
¥ Downloads ” | Quartz.elf 8/18/2021 7:15 PM
3 Documents * | Quartzld 8/18/2021 715 PM
DocumentsMBackup # B Quartz.map /18/2021 715 PM
&= Pictures - | Quartz_HASHED elf 8/18/2021 7:15 PM
PCBandGitHub » | Quartz_HASHED hash 8/18/2021 715 PM
GitHubRepository ~ # | Quartz_HASHED_combined_hash.mbn 8/18/2021 15 PM
| Quartz_HASHED _hash.hd 8/18/2021 7:15 PM
Quectel b 4
| Quartz_ HASHED _merged.elf 8/18/2021 15 PM
Vs * | Quartz_HASHED_nchash.elf /18/2021 715 PM
Docs&FighVideo  # | Quartz_HASHED_phdr.pbn 8/18/2021 7:15PM
DataSheets + | Quartz_nocompact.elf 8/18/2021 7:15 PM
Invoices -+ wllz
13 items

=
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10 Flash the Application to the QCA4020 miniPCle using USB

You can flash an application to the QCA4020 miniPCle over the USB port. To do so, follow the following
steps:

1- Connect a jumper on J3 to short-circuit it. This puts the QCA4020 in EDL (Emergency Download
Mode) which allows to download an image to the QCA4020 flash.

2- Connect a Micro USB cable between USB port on the USB adaptor (HAT) and a USB port on a
Windows PC.

Open the device manager and you shall see Qualcomm DLoader is enumerated on a serial port (i.e.,

COMAQ in this case).

% Device Manager — O *
File Action View Help
e« mEBE T

v 8 LAPTOP-HOSSAMMEW =
I Audio inputs and outputs

| Biometric devices
0 Bluetooth
@_‘ Cameras
[ Computer
e Disk drives
[Gd Display adapters
i Firmware
_"|“; Imaging devices
? Junge Connectivity
=2 Keyboards
L1 Memory technology devices
@ Mice and other pointing devices
[ Monitors
? Metwork adapters
v [ Ports (COM & LPT)

= )
i Qualcomm HS-USB QDLoader 9008 (COMAD)
VAR | B Ll A

= Print queues

= Printers

3- Use the python-based tool called gflash.py (which is included in the QCA4020 SDK). The tool
allows flashing images over USB. The tool is available at the following folder:

| target\build\tools\flash

If the tool is invoked without any optional parameters, it does he following:

a) Generate a default firmware descriptor table.
b) Generate a default partition table.
¢) Flash the default sample application *.elf files to the qca4020 flash.
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When you run this tool with -h parameter, you get the following as in this screenshot:

BE¥ Command Prompt

rmine SDK

$COMM_PORT s

4- Run the following command to flash the application to the QCA4020

python gflash.py --comm_port 40 --app C:\QCA4020\SDK\gca4020-or-3-4_qca_oem_sdk-cdb-

master-
2e23b7b0933311a33dc090ed0f647de9b31d7954\target\quartz\demo\Helloworld_demo\build\g

cc\output\Quartz_HASHED.elf

Noe the image to be flashed is the Quartz_ HASHED..elf.

You shall see the output as in the below screen shoot which indicates the image is successfully flashed to
QCA4020.

@8 Command Prompt

ptor Table @ Fi

8@ Func
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11 Flash the Application to the QCA4020 miniPCle using JTAG

You can use JTAG interface on the QCA4020 miniPCle to flash the image. A SEGGER J-link hardware is
used wit connect and interface to the JTAG.

On the QCA4020 miniPCle, do the following

- Connect J1 (PIN1 and PIN2). This force JTAG mode
- Connect J3 (PIN1 and PIN2). This enable JTAG interface

On Windows environment variables, add the following environment variable:

- JLINK_PATH set it to J-link GDB server executable file (e.g., C:\Program Files
(x86)\SEGGER\JLink)

- CLIENT_PATH set it to ARM GNU tools (e.g., C:\Program Files (x86)\GNU Arm Embedded
Toolchain\10 2020-g4-major\bin)

Using Eclipse IDE, go to Run->External Tools->External Tools Configurations and add a new
configuration. Point to the flash.bat file in the SDK which is used to configure and launch GDB server.
Click Apply and then Run.

S External Teols Cenfigurations o x
Create, manage, and run configurations
3 Extemal tool location dees not exist E‘T
FoEX|B Y- Name: | JTAG Flashing |
[iype fiter text | |/[E] Main| & Refresh| [} Build| B Environment| = Commen
~ @ Program Location:
Qs JTAG Flashing [ €\QCA4020\5DK\qca4020-or-3-4.gea_oem_sdk-cdb-master-2¢2367009333 1 1233<00d0647de0b3 147054\ targes T flash.bat ]
G OpenOCD_ITAG Flashing
Browse Workspace... | Browse File System... | Variables,
Working Directory:
‘ C:\bCAQDEU\SDK\qca4DZD—ur}%,q(a,uem,sdkr:dbrmalev—leZEWbDQBEW1aE]d(DDDEdeM?dEQb3m?954 target! | o\
Browse Workspace... | Browse File System... | Variables,
Arguments:
Variables.
Note: Enclose an argument containing spaces using double-quotes (").
Show Command Line Revert Apply
Filter matched 3 of 3 items
@ R Cle

You will see the following screenshot and prompted to select device or core. Choose Cortex-M4. Click
OK.
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- W Qi e ! 3
{5 Project Expiorer
55 Helloworld_d

Eclipse will start flashing

screenshot.

Project Explorer

Heloworld_demo

B C\Program Files (426)\SEGGE:

tULinkiJLinkGDEServercL exe

Q-G ™ B g .| a A}
[ SEGGER J-Link V652 1 x
Selected Detce: AEM7 teEndan v Cowso v
rarufacnrer core Fiash 52 -~
1
1
f .
i
f -
1
i
1 B
i
f 5
1
1
1 B
i
f 5
L v
i
i B
1 - x O &l
i - | demo'build\qgec'fisshbat (Sep
I - orld_denalb
i 14 dencilt
f . 1
1
f 5
1 B
1
- P
o= cancel

This is free software: you are free to change snd redistribute
There iz WO WARRANTY, to the extent permitted by law

the image to the QCA4020 miniPCle over JTAG. You will see the following

Ead,

[~ & E
1d_dema build gee

Ladlk-cob-master-2623h7h093331 1a33deDS0eci0FBATe0b31 47254 target quartz\deme Helow

File /local/mt/warkspace, CAMBLL 1ds/T0T QT 3.4. r1- 80081 -(ZHd-2_20210201_023482/b/ioesw_prac/cor ge// o013/ jtagprogrammer/sre// Teag €, line 123

Breakpoint 1 ot 0x10846146

Local/mnt /workspace /CRABUL 18

Ao\ . \quartz\deno e Lowor 1a_deno\build\gec\output/Qu

07.G7.3.4.71-00001 - QHH-2_20210201_023452/b/ 40w sw_proc/core/ aner/src//TtagProgranmer 123

2 FASHED.«lf, offset-08304 start _sector=59 num_sectors=6"Rest: binary file . -\ . \quartz\desoitiel Lowor1d_deso\build\ge

_70210201_923452/b
Fb/ioesw_proc/care/stara;

() st /localfmnt/worksp /ioesw_proc/core/starage/tacls/ jtagp tagProg .ci123
iant/warkspace /CAMBuL1d ‘tools/ jtagprogrammer/sr

tagProg:

size BxSeSE Ina Bx16946000
size GxE8c Ima Ox10830000

QEie-2_20210201_823452/b/i0esw_proc/core ge/tecls/tagprog:

QCA4020 miniPCle
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When flashing is completed. You will see the following screen shoot with the output:

Flash Operation Completed Successfully...
Stopping GDB server....

SUCCESS: The process with PID 23756 has been terminated.

23 /1ocal/mntworkspace/CRMBuilds/10T.QZ. 3.
n = "ERASE start_sectorsl num_sectorse2"

Breskpoint 1, main_c () at /loznl/-\l/mrksp-zelcmuudsllo‘r QZ 3.4.r

123 i /loc.ll-nt/-nrlspa(e/cwuud;l!aY Q.3
Flash Operation Completed Successfully..

Stopping GDB server....

SUCCESS: The process with PID 23756 has been terminated.
<

_20210201_( ioesw_pr 8 /jtagprog gProg!
20210201, ¢: foesw_p 8¢/ tools/ Jtagprog 1/3tagProg: e
Writable Smart Insert 69:5:3283

Seeskgotnt 1, mein.c () at /local/ant/workspace/CRIBULIS/IOT.Q1.3.4.r1-00601-GEIM-2 20210201 02452/ Loesw proc/core/storage/ tools/ {tagrogramer/src/ [ tagProgrammer c:113
1-QZHii-2_20210201_023452/b/Ioesw_proc/core/storage/tools/ jtagprogrammer/src// JtagProgrommer.c: Mo such file or directory.

L1123

s
File Edit Source Refactor Navigate Searc
(w R 0% iun Prcim Q ‘w| &
iy Project Explorer £1 =0
5 Helloworld_demo ~
alize resource
is is colled
76= void Initialize Demo(void) ‘
7 {
] PAL_CONSOLE_WRITE_STRING_LITERAL("Hello World demo - Welcome to QCA ToE \r\n"); -
% 79 PAL_CONSOLE_WRITE_STRING_LITERAL(PAL_OUTUT.END_OF_LINE STRING):
o }
void App_Start(gbool t Coldsoot) |
55 QUITthread attr.y Thread_Attribte; E‘
& gurt_thread & Thread_Handle; 2
int Result; |
* Start the main dews app. " v
B Console 1] (%) Problems () Executables [ Debugger Console XK EEPESE ~D-8-= 8|
<terminated> JTAG Flashing [Program] C:\NB _loT_Projects\PCi  gea_oem X
0x10846146 in 7 () "
Loading section RAM_FOM_APPS_RO_REGION, size xScS8 lma €x10046000
Loading section RAM_FOM_APPS_RW_REGION, size @x63c lma 0x10030000
Start address oumszcz load size 25316
Transfer rate: 58 KB/sec, 8435 bytes/write.
1at pace/CRUBUI1ds/10T.QZ.3.4.r1 _20210201 o g Jragprog: /3tagprog: .c, line 123,

After finishing flashing the image, make sure to remove J1 & J3 on QCA4020 miniPCle to exit JTAG mode.
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12 Connecting QCA4020 to Serial Terminal Through UART

You can use the QCA4020 miniPCle when mounted on USB adaptor (HAT) with any device that has UART
(Tx/Rx) interface such as a Raspberry Pl board, Arduino board or any other hardware board, with UART
interface.

You can also use and connect the QCA4020 miniPCle/USB adaptor (HAT) to a USB portin the computer
through a USB-to-UART cable. You can use cable such as this one:

USB TO UART TTL (Wires) Serial Cable (PL2303HX) MCP00102W Programmer Arduino Compatible in
Elecrow bazaar!

Such a cable has four wires colored as follow:
Red: +5V

: Tx

Green: Rx

Black: GND

Connect the White cable to UART_TX and Green cable to UART_RX. Also connect the Black cable to the
GND).

As in the picture below, connect UART_TX to SJ2 (PIN2) AND UART_RX to SJ1 (PIN2).

:I.
non O

JPE2

Sd2

JL

o B
= D

RIS N1
o

<
'_I
[

o
<
]
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Make sure when you connect the USB-to-UART cable, it shows correctly in Windows device manager
and all its driver is installed as in this screenshot.

@ Device Manager — O *
File Action View Help

&= HE HE B BEX®

v % LAPTOP-HOSSAMNEW A
i Audic inputs and outputs
3 Batteries
| Biometric devices
9 Bluetooth
® Cameras
E Computer
s Disk drives
[5d Display adapters
* Firmware

3% Imaging devices
? Junge Connectivity
Keyboards
LI Memory techneology devices
g Mice and other pointing devices
[ Monitars
I Network adapters
v [ Ports (COM & LPT)

y - SOL (COM3)
USE Serial Port (COM31)
rint queues

=i Printers
I Processors

B Comivvidns Admsimmr

13 Using Serial Terminal

It is recommended to use Tera Term tool as the serial terminal. You can download it from here:

https://osdn.net/projects/ttssh2/downloads/54081/teraterm-4.72.exe/

Launch Tera Terminal and select the Serial option and select USB-to-Serial port.

Tera Term: New connection X
CTCPHP Host: myhost.example.com
History
Service: L Telnet TCP porti: |22
SSH SSHversion: [SSH2
Other

IP version: [AUTO

® Serial Port: | COM31: USB Serial Port (COM31) ~

oK Cancel Help
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In Tera Term, choose Setup->Serial port and configure serial ports according to the following:

Tera Term: Serial port setup and connection Pt
Port: COM31 ~
New setting

Speed: 115200 v

Data: 8 bit v cancel

Parity: none ~

Stop bits: 1 bit ~ Help

Flow control: none v

Transmit delay

D msecichar El msecfline

Device Friendly Name: USB Serial Port (COM31)

Device Instance ID: FTDIBUSYWID_0403+PID_600147&1CBBEEF7&
Device Manufacturer: FTDI

Provider Name: FTDI

Driver Date: B-16-2017

Driver Yersion: 2.12.28.0

And now you are ready to see the output from “hello World” application on the serial monitor.

v COM31 - Tera Term VT = d >
File Edit Setup Control Window Help

World QCA482A miniPCle
World QCA4828 miniPCle
World QCA4828 miniPCle
World QCA4828 miniPCle
World QCA4828 miniPCle
World QCA482A miniPCle

World QCA4828 miniPCle
World QCA4820 miniPCle
World QCA4828 miniPCle
World QCA4820 miniPCle
World QCA4820 miniPCle
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If you are using JTAG mode to flash the image to the QCA4020 miniPCle, you shall see the following
output on Tera terminal

MCOM3T - Tera Term VT — O >

File Edit Setup Control Window Help
Hello Yorld from QCA46828 miniPCle

World from QCA4B28 miniPCle
World from QCA4B28 miniPCle
World from QCA4B28 miniPCle
World from QCA4B28 miniPCle
Yorld from QCA4B28 miniPCle

Yorld from QCA4B28 miniPCle
World from QCA4828 miniPCle
World from QCA4828 miniPCle
World from QCA4828 miniPCle

QCA4020 miniPCle Copyright © 5GHUB.US



https://5ghub.us/

14 QCLI Demo Application

CLI demo application is a comprehensive demo that provides a mechanism to demonstrate different and
all features and technologies that QCA4020 miniPCle supports. It also provides reference implementation

and usage of customer facing QAPIs.

The QCLI-demo application is available with the QCA4020 SDK and you can follow the same steps
described before in Eclipse to build and flash it to the QCA4020 miniPCle. Once flashed, you can see
the output on the serial terminal as in the screenshot below. Also, you can exercise connecting to

your home/office WLAN

¥ COM3T - Tera Term VT

File Edit Setup Control Window Help

WMI: HMI Demo Initialized.
ULAN: WLAN Registered
WLANSP2P: WLAN P2P Registered
Het: Met Registered
Coex: Coex Demo Initialized.
Fulp: Firmuware Upgrade Registered
LP: LP Registered
: Fs Registered
ztem: Ecosystem Registered
SecureFs Registered
: Crypto Registered
: ZigBee Demo Initialized.
Thread: Thread Demo Initialized.
Platform: Platform Registered
JEOM: JS50N Demo Registered.
FLASHLOG: FLASHLOG Registered
UART: UART Registered

. Ecosystem
- SecureFs
. Crypto

. ZigBee

. Thread

. Platform

. JSON
. FLASHLOG
UART

The following screenshot shows how to connect to an WLAN access point.
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v COMB31 - Tera Term VT

File Edit Setup Contral Window Help
WLANS> Enable

WLANS > scan

ULAN: Scan result coun

WLANS > scan

LULAN d TPLink

WLAN: bssid hi :?6:ch:d6:5h

WLAN: channel

ULAN: indicator i@

ULAN: security =

REN-WPAZ= {PSK > {TKIP AES }

WLAN: shell> Scan result count:l
WLANS> SetDevice 1

WLANS> SetlpaPassphrase Yusuf@50209
WLANS> SetUWpaParameters WPAZ CCHP CCHMP
WLANS > Connect TPLink

LLAN:

WLAN: Setting SSID to IPLink

WLAN:

WLANS >
WLAN: devld 1 Disconnected MAC addr B0:08:00:00:80:00

WLANS > Connect TPLink

ULAN:
WLAN: Setting S8ID to TPLink

ULANS >

WLAN: devId 1 Disconnected MAGC addr B0:00:00:00:00:00
WLAN: devid — 1 1 CONMECIED MAC addr b =76

WLAN: 4 way handshake success for device=1

WLANS > 0
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